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ABSTRACT

Computational models of the human anthropomorphic phantom have undergone
progressive evolution since initial development more than sixty years ago (Xu 2014).
Computational phantoms employed by the Nuclear Regulatory Commission (NRC) were
largely based on a model published in 1974, which did not account for select organs (e.g.,
neck, esophagus) and tissues. This was exacerbated by inaccurate organ placement
within the body (e.g., thyroid). Most notably, all the computational phantoms were
assumed to be in the vertical-upright position, which continues to be a trend in the
development of current computational phantoms. To assess the radiation dose in different
configurations when needed, the mathematical phantom had been revised to enable
freely moving abilities for arms and legs. The revised phantom is called PiIMAL: Phantom
with Moving Arms and Legs (Akkurt and Eckerman 2007).

The PIMAL software is intended to be coupled with Monte Carlo N-Particle (MCNP)
(Pelowitz et al. 2013) to allow radiation transport simulations for estimating radiation dose
to humans. The newest version (6.0) also allows dose assessments to humans from
medical sources in moveable phantoms of domestic pets (cats, dogs, and horses). The
MCNP code can be run natively from the PIMAL interface, or externally in the MCNP
command prompt via the generated MCNP input file. Both internal and external sources
can be simulated in PIMAL selecting from a drop-down menu in the user interface. The
user can also select an organ in the chosen animal in which radioactive material may be
placed. Internal sources are assumed to be uniformly distributed within the selected
organ. For external sources, in addition to a point source, the user can select the ICRP’s
standard external exposure geometries (AP, PA, LLAT, RLAT, ISO). Advanced users of
MCNP can add their own simulation characteristics to the PiMAL-generated MNCP input
deck prior to running the code.
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1 INTRODUCTION

The PIMAL software is intended to provide input decks for Monte Carlo N-Particle (MCNP)
simulations. These files are based on movable human and animal phantoms and their
relationship to each other and to the source of a given radiation emission. By itself, the
PiIMAL software can be useful for scenario visualization, but when used in combination
with MCNP its full power is displayed.

Radiation sources can be external to the phantom(s) or embedded in one or more organs
of a given phantom. For example, the effective dose to a human female can be assessed
for an exposure to her domestic feline having undergone a radioactive iodine treatment
for hyperthyroidism.

In the initial phase of development (Akkurt and Eckerman 2007), the objectives for
developing PIMAL were three-fold: (1) update the Medical Internal Radiation Dose
(MIRD)-5 mathematical phantom model that was then used by the U.S. Nuclear
Regulatory Commission (NRC) staff to improve the assessment of dose for realistic
exposure configurations; (2) perform benchmark computations against International
Council on Radiological Protection (ICRP)-74 (1996) values and investigate the reasons
behind any identified discrepancies, and (3) develop an interface to assist the user (or
analyst) in using the updated phantom model in dose assessment activities thus reducing
staff time.

Updates were made to the organs and compositions of anthropomorphic phantom
models. The revised computational phantom model was adopted for radiation transport
codes, notably the Monte Carlo N-Particle (MCNP) code (Pelowitz et al. 2013).
Computational results generated were compared against values reported by the ICRP in
Publication 74 (1996), with discrepancies identified, rectified, and resolved. Although the
original PIMAL phantom was developed as an adult hermaphrodite model, with both male
and female gender-specific organs for both genders, the latest revision of PiIMAL
separates the male and female option in the graphical user interface (GUI) for calculating
doses. Finally, a GUI assists the analyst with input preparation and output manipulation.
The GUI can be used to visualize the positioning of the arms and legs as the desired
posture is achieved to generate the input deck, invoke the computations, and extract the
organ dose values from the MCNP output deck. The GUI was operating system
independent since the coding was done in Java. A phantom model was included in the
GUI, thus enabling visualization of the arms and legs as positioned. Once the user
decides on the posture, an MCNP input deck can be generated and the radiation transport
simulations using MCNP can be performed through the GUI. Furthermore, the organ dose
values can be extracted (from the MCNP output deck), displayed, and exported as an
American Standard Code for Information Interchange (ASCII) file.

The PIMAL 6.0 project was undertaken to add the capability of including domestic animals
(i.e., cat, dog, horse) to the dosimetry simulations, as well as to update data libraries and

1-1
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coding efficiencies. With increased use of radioactive materials in the treatment protocol
for diseases and ailments in pets, a method was needed to estimate radiation dose to
humans (e.g., pet owners) from those sources. PiMAL 6.0 allows the user to place an
animal phantom in the same MCNP universe with a human phantom. Radioactive source
locations in the animal can then be selected for human exposures. At this stage, radiation
dose to animals is not calculated.

As contracted, Renaissance Code Development (RCD) is actively working to comply with
Section 508 of the Rehabilitation Act of 1973 (as amended by 29 USC 794d) by
conforming to the Act and supporting the requirements of the Standards for Section 508
(36 CFR 1194.1). This conformance is ongoing, and the User will see edits throughout
the lifecycle of PIMAL, and other Radiation protection computer code Analysis and
Maintenance (RAMP) software, to demonstrate compliance.

The culmination of the PIMAL work, authored by various groups since its inception, is a
detailed mathematical phantom model with freely moving arms and legs to enable the
analyses of realistic exposure configurations and an accompanying GUI to facilitate
phantom postures and dose assessment analyses.

1-2
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2 INSTALLATION

Installation instructions are provided here for a Microsoft Windows based system. The
installation process of PIMAL itself requires downloading and installing the executable file
from the NRC RAMP website (https://ramp.nrc-gateway.gov/codes/pimal). Unlike
previous versions, the user is not required to have Java installed on their machine; the
required Java run-time libraries are included with the installation package.

Once RAMP access has been granted, and the user is logged into the RAMP website,
the Download option can be found by navigating to the PIMAL code menu (Figure 2-1).

Step 1. Download the PIMAL executable file.

Code Menu

PIMAL Overview

Figure 2-1 Downloading Install Exectuable from RAMP Website.

Step 2. Double-click the zipped .exe folder (Figure 2-2) to download the
executable.

2-1
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Download PIMAL

2 files | 51545 MB

NAME & SIZE DESCRIPTION
: 515.34 ; o
[ PIMAL-5.0exezp PIMAL 5.0 Code (Zipped EXE)
MB
PIMALS5.0 Release notes associated with the PIMAL update to the PIMAL
I} 103.41KB )
ReleaseNotes.docx code

Figure 2-2 Download Options for the PIMAL Executable and its Release Note.

Once downloaded to your computer, open the installer executable to begin the install and
setup processes for PIMAL. When installing, a Windows Defender SmartScreen may
appear if your computer is so configured. If this occurs, select “More Info” to expand the
visible options and hit “Run Away”.

Step 3. Click Next on the Setup Wizard window (Figure 2-3).

Welcome to the PIMAL-6.0 Setup Wizard

The Setup Wizard will install PIMAL-6.0 on your computer.
Click Next to continue or Cancel to exit the Setup Wizard.

Next ] Cancel

Figure 2-3 PiMAL Setup Main Install Window.

Step 4. Choose your install destination folder (Figure 2-4); this is where the
program is to be installed. This is separate from the working directory where
program inputs and outputs will be stored. The working directory is defined by the
user in a later step.

The default install destination folder for PiMAL is:
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C:\Users\<username>\AppData\Local\PiIMAL-6.0
"M PIMAL-6.0 Setup

Destination Folder
Click Mext to install to the default folder or dick Change to choose another.

Install FiMAL-6.0 to:

x

|C: \Users\<username > \appData'Local PiMAL-6.0Y

Change...

Cancel

Figure 2-4 Defining PiMAL Installation Directory.

RCD-25-008-0

Tip: By default Windows will hide the AppData folder. The user can
navigate to this location by explicitly typing the address in Windows
explorer address bar or by adjusting the system settings to show
hidden files and folders. This can be set by following these
instructions: https.//support.microsoft.com/en-us/windows/view-

hidden-files-and-folders-in-windows-97fbc472-c603-9d90-91d0-

1166d1d9f4b5.

Step 5. Click Install (Figure 2-5) to start the installation process.
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Ready to install PIMAL-6.0

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back [ Install Cancel

Figure 2-5 PiMAL Setup Install Window.

The window will update to show the progress of the installation. This should take less
than a minute.

Step 6. When the setup is complete, click Finish in the Setup Wizard (Figure 2-6).

Completed the PIMAL-6.0 Setup Wizard

Click the Finish button to exit the Setup Wizard.

(Feh )

Figure 2-6 PiMAL Setup Window Installation Complete Window.

Step 7. Confirm installation was successful. Once the setup has been completed
the following will exist on the user’'s machine:

PiMAL-6.0 shortcut on the desktop (Figure 2-7)
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RAMP Start Menu Folder containing a PIMAL-6.0 shortcut (Figure 2-8)

Figure 2-7 Desktop Shortcut for the Installed PIMAL Executable.

RAMP o

@ PiMAL-6.0
V& varskansz

V& varskn+s

Figure 2-8 RAMP Start Menu Folder Containing a Link to the PiMAL
Executable.

Step 8. Double click the PIMAL icon that was created on the desktop or select the
link generated in the RAMP Start Menu folder. PIMAL requires 5 to 7 seconds to
initialize on opening. Once opened, the simulation input window will be displayed
(Figure 2-9).

() PIMAL v6.0 - X

Phantem View Preferences Help

Camera Controls Human Female
Simulation Material Visibility
@ Heart

@ Spleen

@ Brain

@ Eyes

@ Biliary System

@ Gastrointestinal Tract

@ Urinary System

@ Respiratory Tract

@ Gender-Specific Organs
O Skin

Generate MCNP Input

Save Image Reset

Figure 2-9 PiMAL Simulation Input Window.
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3 SOFTWARE CONFIGURATION

Before using PIMAL for the first time, a few customization settings are required to be input
by the user. The following sections will walk through:

e setting the working directory where program inputs and outputs are stored;
e setting the path to the MCNP executable; and

e setting the path to the MCNP batch file that sets the environmental variables
required for executing MCNP.

Linking PIMAL and MCNP allows the two codes to interface and obtain dose results in a
seamless process.

3.1 Setting the Working Directory

As MCNP inputs are created, configurations selected, and MCNP is executed through
PIMAL, these generated files need to be saved locally. The user must decide where these
files are to be saved by setting the working directory. This directory should be accessible
in that administrative level privileges are not required where the user had read and write
permissions.

To set the working directory, navigate to the PiIMAL toolbar and select Preferences >
Change Working Directory.

By default, the current directory will be set to:

C:\Users\<username>\Documents

Set Warking Directory X

':e:' Warking Directory: C:\JJsers'n,{username}hDDcumenm Search

Cancel

Figure 3-1 Changing Working Directory Window.

Click Select. In the pop-up that follows, navigate to the folder where the files are to be
saved.

3-1



Figure 3-2

Click on the designated destination folder and press Open.
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Look in:

M

Recent [tems

>

eskto

1

Documents

(=)
h=]

'ﬂ

5
E
o
(]

s

MNetwark

= Documents w

% £ @

Custom Office Templates
MetBeansProjects
OneMote Notebooks
Outlook Files

Projects

toolbox_test

Visual Studio 2022

Folder name: | C:\Jsers\username\Documents

Files of type:  all Files

Cancel

Specifying Working Directory Location.

Click OK on the directory window (Figure 3-1). The working directory folder is now set as
the default save folder for PIMAL configurations and MCNP run files.

3.2 Setting the Path for the MCNP Executable

It is assumed the user has successfully installed MCNP on their machine; instructions for
that install are not provided here. If MCNP has not yet been installed, please request the
code through appropriate channels via the Radiation Safety Information Computational
Center (https://rsicc.ornl.gov). MCNP is not required for running the PIMAL GUI (e.g.,

articulating limbs/positions), but radiation transport is not possible without an installed
version of MCNP.

The path to the MCNP executable directory must be set in PIMAL so that MCNP can be
called from within PIMAL.

On the PIMAL toolbar, select Preferences > Set MCNP Command.
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Set MCHNP Command *
ie} MCNP Command: |C:\My_MCNPYMCNE_CODE hinimenps. exe Search

Figure 3-3 Setting the MCNP Executable Location.

The MCNP command must include the absolute path to the executable. If the installation
was performed as directed in the MCNP manual, the typical default install location is:

C:\My_MCNP\MCNP_CODE\bin\mcnp6.exe.
If an environmental variable has been set (e.g., mcnp6) it may also be entered here.

If the MCNP location needs to be updated, enter the new install location in the text field
and select OK.

Tip: To obtain the MCNP installation location, open the MCNP
command line shortcut on the desktop and enter: “where mcnp6”.
The absolute path of the MCNP executable (*.exe) will be returned
as well as the location of the environmental variable batch file (*.bat).
This paths can be copied and pasted into the path location as
necessary.

3.3 Setting the MCNP Environmental Variable Batch File

The MCNP batch file is generated as part of the MCNP install process depending on the
version of MCNP and the user’s setup. If not needed it may be left blank. This batch file
defines the necessary environmental variables required by MCNP during execution. The
typical default install location is:

C:\Users\<username>\mcnp_env_620.bat.

On the PIMAL toolbar, select Preferences > Set Environment Variable BAT to specify
where the MCNP batch file is located.

Tip: To find the location of the MCNP batch file, right click on the
MCNP command line icon on the desktop and select properties. The
batch file location is identified under the "details" tab.

3-3
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Change Environment Batch

IOI Batch File: Search

Cancel

Figure 3-4 Setting the MCNP Environment Variable Batch File Location.

Press Select and navigate to the MCNP batch file. Click on the designated file and press
Open.

Look in: ~| Documents o ¥ % E,

Custom Office Templates
% MetBeansProjects

Recent [tems OneMote Motebooks

Qutlook Files

Projects

toolbox_test

Visual Studio 2022

]

eskto,

:

h=]

Documents

This PC

ﬁ Folder name: | C:\Usersiusername\Documents
Network  Flesoftype:  alFies % Cancel

Figure 3-5 Specifying MCNP Environment Variable Batch File Location.

Press OK on the batch window (Figure 3-4) when complete.

MCNP is now configured and can be executed by selecting “Generate MCNP Input” in
the lower right corner of the input window. To run a PiMAL-generated input deck through
MCNP, select “Run MCNP” (bottom center) on the pop-up window that has opened after
selecting Generate MCNP. If MCNP is unable to link to PIMAL, an error message will be
displayed in the “MCNP Console” tab; otherwise, the run status of the current problem

will be displayed.
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4 USERINTERFACE

Once the installation process has been completed and you have configured PIMAL to
work with MCNP, PiIMAL is ready for use. Of immediate interest is the graphical user
interface, or GUI, that allows for the easy customization and display of the phantom. In
the following sections, the GUI overview, as well as camera controls and other important
elements of PIMAL, will be discussed. Pressing the reset button on the main window will
reset the simulation entirely to default (3D) values.

Warning: Breaking the physical limitations of the phantom has the likely effect
of causing fatal errors in MCNP. Please be cautious not to overlap one portion
of the phantom with another (e.g., impaling the head with the fist, causing legs
or arms to intersect, crossing human features with animal features, etc.).

4.1 GUI Overview

Particular GUI features of interest are noted in Figure 4-1 with numbers 1 through 6.
Those numbers point out the following: (1) PIMAL Toolbar; (2) 3D View Tabs; (3) Java3D
Environment; (4) Phantom Parameters Tabs; (5) Main Buttons; and (6) Phantom(s)
location.

O

i 2 Transparencies Camera Controls
Simulation
Human Female Animal, Dog
AnimalMass 30 kg 4

B

; I
X Locahon_aoo 300 -37
|
Y Location 300 300 -37
|
Z Location 80 95 -7
I
Z Rotation 0 350 0
Left Forelimb, Knee
e
YRolaImn_m 1700
Left Forelimb, Ankle
ion |1
Y Rotation 17,00

Right Forelimb, Knee
Y Rotation .ln 2=0l0

Generate MCNP Input

Save Image Reset

5

Figure 4-1 Graphical User Interface (GUI).
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4.2 3-D Camera Controls

Inside the Java3D environment, the user can change the camera view or its angle using:
(1) mouse right-click and drag to rotate camera; (2) mouse left-click and drag to change
camera position; and (3) mouse middle scroll to zoom in and out.

In the Camera Controls tab, there is the option to change the zoom rate from 0 to 16, with
a default of 8. Lower numbers will zoom with the mouse wheel slower than higher
numbers. There is the option to either input the number manually (followed by the enter
key), or by using the slider. Itis up to the user to decide which method works best for their
preferences or situation.

In this tab, there is also the option to change the slew rate. The values you can enter
range from -0.5 to 0.5. This will increase or decrease the rate at which the phantom
rotates in the Java3D window. The lowest value (+/- 0.01) is the slowest rotation speed
and will function to provide the most control over the rotational position of the phantom in
the window. Values change the response direction as well as speed; with a negative
value, moving the mouse will rotate the image against the direction of the mouse. With a
positive value, moving the mouse will rotate the image in the direction of the mouse.

Note: Changing the rotation, position or zoom of the phantom in the Java3D
window does not change the position of the phantom in the MCNP simulation.
It is for viewing purposes only, meant to identify how the limbs are positioned,
where the companion phantoms are positioned with respect to the human, and
any other small details the user wishes to evaluate before starting a simulation.

To reset the phantom’s rotation position, click the Camera Reset button in the camera
controls pane.

4.3 Human Tab

If the human phantom is selected, the “Human Female” or “Human Male” tab will be
shown. If the sliders window is not open on the sidebar, click on the Human
(Male/Female) tab to open.

Human tabs include slider and text boxes allowing the movement of the arms and legs
for the human. Clicking and dragging the slider for each labeled rotation moves the
respective appendage. Experiment with each of the 16 sliders to understand what each
one does. It is possible to rotate each of the arms about the shoulder in both the X axis
(around the shoulder, parallel to the body) and Y axis (up and down perpendicular to the
body) independently. Selecting shoulder rotation moves the whole appendage from the
shoulder and selecting the elbow rotation moves just the lower appendage from the
elbow. The lower limbs rotate in the same manner.
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Using the sliders moves the selected appendage in real time. If you use the text box to

enter a value, either hitting “enter”, “tab”, or moving the mouse pointer/cursor out of the
text field will update the input value.

A

It is possible to move the limbs in a way that will impale the limb
into the body or the other limbs. Please take care not to do this,
as the Java3D window does not account for geometry errors that
can occur in the MCNP files. An impaled limb will result in a fatal
error when MCNP is run, and no organ doses will be calculated.

44 Animal Tab

If an animal is selected from the Phantom drop-down menu, it will appear in the Java3D
environment with the human (the human can be removed by de-selecting the human

phantom).

A

PiMAL is not built for the purposes of computing dose to the
animals, and as such, when you deselect the human from the
JAVA3D environmnent and generate an MCNP input, there are
no tallies written to the file. This use case should be for advanced
users who wish to manipulate the files with their own knowledge
of MCNP.

Figure 4-2 shows the default stance of the phantom, with all sliders at zero position.
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() PIMAL v6.0 - X

Phantom View Preferences Help

Simulation Material Visibilitv
Camera Confrols Human Female
Right Shoulder
X Rolal|0n7359 0 EI
¥ Rotation w0l |
Right Elbow

_ |

X Rc-tatloni1 50 0 EI
, |

Y Rotation 35 a0 El

Left Shoulder

, |

X Rc»tatlon_359 0 El
, |

Y Rotation 180 0 El

Left Elbow
X Rotation I 0 ‘

Generate MCNP Input

Save Image Reset

Figure 4-2 Default PIMAL Stance.

There are options to choose from a cat, a dog, or a horse in the phantom selection menu
(Figure 4-3). Each has nearly identical bodies, except small changes in face distribution,
neck, and leg lengths.

() PIMAL v6.0

File Phantom View Preferences Help

* Human Female

Human Male

Animal, Dog
Animal, Cat

Animal, Horse

Figure 4-3 Phantom Selection Menu.

Once the animal appears in the Java3D environment (Figure 4-4), the user can select the
location and mass of the companion animal by selecting the Animal tab. Much like the
human phantoms, the animal phantoms have limb movement capabilities. Inputting limb
rotations works similarly to the human phantoms where one can use sliders to angle
limbs, or input numbers into the text boxes. Pressing “Enter”, “Tab”, or simply moving the
cursor outside of the text box will accept the change in the Java3D environment. Changing
the mass of the animal will scale it proportionally and result in an animal with



RCD-25-008-0

proportionally sized organs and limbs. The animal type selected will appear in the title of
the Animal tab. In the example below, we see we have “Animal, Dog” and its mass is 30

kg.

() PIMAL v6.0 - %

Phantom View Preferences Help

Simulation Material Visibility Camera Conirols
Human Female Animal, Dog

Animal Mass ka
X Locationi300 I 200

, I

Y Location 300 200
. I

Z Location 100 100
|

Z Rotation 0 BSQD

Left Forelimb, Knee

, |
Y Rotation 40 80 D

Left Forelimb, Ankle

o
Y Rotation 10 150@

Right Forelimb, Knee
{ | —

Generate MCNP Input

Save Image Reset

Figure 4-4 Companion Animal Parameter Tab.
4.5 Setting Phantom Visibility

To give access to organ visibilities, select the Material Visibility tab on the sidebar. By
checking the box for a given tissue/organ, the tissue/organ becomes visible in the Java3D
environment. Unchecking a given box results in the tissue/organ becoming transparent.
Unless manually removed by the experienced user, the organ is always present in the
MCNP input deck, but simply not visible in the camera image.

Note that the bones have been made transparent in Figure 4-5 (right-hand image).
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Bhantom View Preferences Help

Camera Controls Human Female
Simulation Material Visibility

@ reart

® Spleen

8 Brain

@ Eyes

@ Biliary System

8 Gastrointestinal Tract

® Urinary System

@ Respiratory Tract

8 Gender-Specific Organs

O Skin

8 Bone

O Soft Tissue

Generate MCNP Input
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Bhantom View Preferences

- X

Camera Controls Human Female
Simulation Material Visibility

@ Hearnt

@ Spleen

@ Brain

B Eyes

@ Biliary System

8 Gastrointestinal Tract

@ Urinary System

@ Respiratory Tract

8 Gender-Specific Organs.

O Skin

OBone

O Soft Tissue

Generate MCNP Input

Save Image Reset

Figure 4-5

4.6 Resetting the Phantom

Un-checking the “Bone” Visibility Box.

Pressing the reset button located in the bottom right corner of the GUI will return the
female phantom with all appendage rotations to zero and the transparencies of
tissues/organs returned to the default settings. If an animal had been selected, it will be

removed from the Java3D environment as part of the reset.

Figure 4-6

Generate MCNP.Inpt

Save Image

Reset Button.

To return the camera view angle to its original position, click on the “Camera Reset” button
in the “Camera Controls” tab.
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Joulation Transparencies
Camera Controls Human Female

3D

Zoom Rate 010 16.00 10.00

Slew Rate 050 050 0.08

( Camera Reset >

Figure 4-7 Camera Reset Button.

Note that resetting the camera and the phantom will not change any values the
user selected for Zoom Rate or Slew Rate in the camera controls tab, nor will
any simulation parameters in the Simulation Tab be reset.

If an animal is selected and the user changes its mass, PIMAL’s default behavior is to
reset its position relative to the human. If the user prefers the animal’s position remain
fixed while changing the mass, de-select that option from the preferences menu.
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P PIMAL v6.0 - @ X
File Phantom Vi@ielp
Change Working Directory .
Transparencies Camera Controls
Set MCNP Command = =
) ) Simulation
Set Environment Variable BAT Human Female Animal, DOQ
Set Source NPS
Sk e Cola Animal Mass _300 | kg
200 = 30045
Y Location 2300 300 ;_45 |

Animal Location Reset Button.

Figure 4-8

Z Location 80 o5 '_0
Z Rotation 0 359 0
rLeft Forelimb, Knee
YRotalion_w 170-0
rLeft Forelimb, Ankle

| :
YRotallon_m 170-0

rRight Forelimb, Knee

)

Y Rotation ,ln

Generate MCNP Input

Save Image Reset
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5 BUILDING THE MCNP SCENARIO

Once the positioning of the phantom(s) is complete, the next step of the process is to
generate the MCNP input deck. This includes defining a source, allowing PiIMAL to
generate the file, displaying source points for source validation, and saving the input.
Custom source creation is introduced in this section. Most of this section will deal with
the Simulation tab in the right-hand sidebar (Figure 5-1).

Human Female Animal, Dog
Simulation  Material Visibility =~ Camera Controls

Source Monoenergetic Photon e
Energy 1.0 MeV

Configuration Point Source (Internal) ~

Source Position

X|0.0 cm
Y |-50.0 cm
7200 cm
Activity 1 Bg
Residence Time 1 hr
Generate MCNP Input
Save Image Reset

Figure 5-1 Depiction of Simulation Tab on Sidebar.
5.1 PIMAL Built-in Source Settings

PiIMAL contains numerous built-in sources for user convenience. These databases will
be updated with more source options as time goes on. Currently available source
distribution options are: (1) monoenergetic photons or neutrons; (2) radionuclide photon
emissions (Co-60, Sn-117m, 1-131, Cs-134, Cs-137, Lu-177, and Ir-192); (3) X-ray
emission spectra (60, 80, 100, and 120 kVp); and (4) (a,n) reaction neutron sources
(AmBe and PuBe). The advanced user can add their own source distributions, as
necessary.

The Configuration drop-down menu is for the selection of a source location, or geometry.
The configuration options are:
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e Point source: the source is location as a point defined by the position entered in
the X, Y, Z text boxes;

e Anterior-Posterior (AP): particles enter the phantom through the front (anterior)
surface and exit through the back (posterior) surface;

o Posterior-Anterior (PA): particles enter the phantom through the back surface and
exit through the front surface;

o Left/Right Lateral (LLAT/RLAT): particles enter the phantom through the left or
right lateral surface exiting on the opposite side;

e |sotropic: the source is located on a spherical surface surrounding the phantom;
and

¢ Internal Organs: the source is located in a specified organ. If a companion animal
is selected, additional source location options for animal internal organs will be
present.

The default number of particle histories is 100,000. The user can change this value in the
Simulation tab. If other source inputs are desired, the advanced MCNP user can select
one of the above options and then modify the input deck or build their own source data.

The pre-built source definition and configuration combinations allowed are identified in
Figure 5-2.

Select Source

Source Type Type 1: Type 2: Type 3:
Photon Emitting Nuclide X-Ray Monoenergetic Neutron
Monoenergetic Photon AmBe
PuBe
Allowed Point (External) Point (External) Point (External)
Configuration Point (Internal) AP, PA, AP, PA, AP, PA,
Organ LLAT, RLAT, LLAT, RLAT, LLAT, RLAT,
ISO ISO ISO
Source Inputs Activity Activity None
Residence Time Exposure Time Current*Time

Figure 5-2 Allowed Source Type and Configuration Combinations.
5.2 Generating MCNP Input

To generate the MCNP input deck, press the Generate MCNP Input button (Figure 5-1).
Figure 5-3 shows an example of the MCNP input window that results from pressing the
Generate MCNP Input button. The contents of the MCNP input deck can be edited

5-2



RCD-25-008-0

through the input window using the built-in text editor. Changes made to the input deck

will be saved and used in the current MCNP run.

2 PIMALV6.0

MCNP MCINP Console  MCNP Output Organ Dose

7]
C Uterus
(s@)
C Ovaries
(78 79)
C Thyroid
(19)
C Esophagus
(49 51)
C Bladder
(75 76)
C Liver
(44)
C Bone Surface
(234252627 28 29 38 31 85 97 189 125)
C skin
(1 84 93 185 119 136)
C Brain
(8)
| C salivary Glands
(23)
C Upper Large Intestine
(57 58 68 61 63 64)
C Lower Large Intestine
(66 67 69 76 72 73)
C Eyes
(7 8)
C Source definition.
SDEF POS=8.8 -58.8 28.8 ERG=1.8 PAR=P
MODE P
C Particle track output definition.
PTRAC FILE=ASC MAX=5808@ WRITE=POS EVENT=SRC
C Stopping criteria.
NPS 180000

Save Input Deck Run MCNP Load Qutput Deck

Figure 5-3 MCNP Window.

5.3 Displaying Source Points

Source points will automatically display in the Java3D environment once a successful
MCNP simulation is run (Figure 5-4). This is a convenient way to visualize the geometry
of the source in and around the phantom. The user can disable the source display feature

through the View drop-down menu (Figure 5-5).
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Figure 5-4 Source Point Display of LLAT Geometry with Companion Animal.
Adjustable settings for source display are:

o Source Display Color: The color of the displayed source points can be set
and changed in Preferences > Set Source Color; and

o Display Source Particles: The user can toggle on/off display of source
locations in View > Display Source Particles. This will automatically show
source particles when an MCNP run has finished successfully.

If a given source emission point happens to fall directly on a defined MCNP surface,
MCNP will end in a failed run. An unsuccessful simulation will result in a blank dose form
(Figure 5-6).
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) PIMAL v6.0
File Phantom View Preferences Help

Display Coordinate Axes

3D

v Display Source Particles

Figure 5-5 Source Particle Display Option.

) PIMAL VG0

MCNP Input  MCNP Console  MCNP Qutput ; Organ Dose
ICRP 26 ~

Exportto CSV Effective Dose (Sv).  NIA

Figure 5-6 Blank Dose Form Indicating an Unsuccessful MCNP Simulation.

5.4 Saving Input

To save the MCNP input deck, navigate to the button at the bottom of the MCNP terminal
screen (Figure 5-3). Press Save Input to open the save dialog window (Figure 5-7):
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Save in: Outputs v e
(TS
Recent Items
Desktop
Documents
This PC
Ml e [praie

Network Files of type: Al Files 7 Cancel

Figure 5-7 Save Input Window.
In this window, enter the file name and press save to complete the process.
5.5 Steps to Entering Custom MCNP Configurations

PiIMAL contains a few optional sources for simulation, but other sources may be desired.
When the need arises, a source may be defined manually.

The steps for entering a custom source are outlined as follows:

1. save the MCNP input deck and open the new, custom source file in a text editor,
or edit within the Generate MCNP Input window using the built-in text editor;
make changes to the Materials card (addition of materials);

make changes to Cell/Surface cards with inclusion of materials;

adjust the source definition (SDEF); and

save the new source input deck.

A

If the tally specifications have not been altered (including syntax), running an edited
version of the MCNP input deck should be possible. This will still make available organ
tally information in the MCNP terminal screen, as well as source points in the Java3D
screen (if selected in the view menu).

MCNP will not run radiation transport and will not result in an answer if a cell, surface, or
material has the same number as one already defined in the input deck. For this reason,
if you add to a phantom, you must ensure that numbering does not overlap. For example
(see Table 5-1), if adding to female phantom geometry, you must use cell numbers
greater than 132, surfaces greater than 338, etc.
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Base Index Numbers for Placing Cells, Surfaces, or Materials.
Cell Surface Material
Numbers Numbers | numbers
Female Phantom 1-132 1-338 1-25
Male Phantom 1-134 1-305 1-25
Animal Phantoms | 200-259 2000-2353 1-25

o-7
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6 RUNNING MCNP

PIMAL creates an MCNP input deck based on settings provided by the user. The next
step is to run MCNP using the new input deck and extract dose tallies. In this section, the
options for running a PiMAL-generated MCNP input deck and viewing the organ doses
from the MCNP output deck are presented.

6.1 Executing the MCNP code through PiMAL

MCNP can be executed through PIMAL without having to use the MCNP command line.
Once the user has phantom(s) arranged, click the Generate MCNP Input button (lower
right corner of the PIMAL input screen, see Section 5.2) to create the input deck and
display it in the MCNP operations panel (Figure 6-1). The operations panel can be treated
like a text editor in that the user can make changes to the file directly in the panel. These
edits, however, are not saved to the input deck unless the user explicitly clicks the Save
Input Deck button in the lower left of the operations panel.

PiMAL v6.0 = [m] X

MCNP Input; ICNP Console MCNP Qutput Organ Dose

er
(a4)
C Bone Surface
(2342526 27 28 29 3@ 31 85 97 189 125)
C skin
(1 84 93 185 119 136)
C Brain
(8)
C salivary Glands
(23)
C Upper Large Intestine
(57 58 6@ 61 63 64)
C Lower Large Intestine
(65 67 69 78 72 73)
C Eyes
(7 8)
C Source definition
SDEF P0S=8.8 -58.8 28.8 ERG=1.8 PAR=P
MODE P
C Particle track output definition.
PTRAC FILE=ASC MAX=5888@ WRITE=POS EVENT=SRC
C Stopping criteria
NPS 180008

Save Input Deck Run MCNP Load Output Deck

Figure 6-1 MCNP Operations Panel.

The operations panel displays the input deck by default but can also be used to view the
MCNP Console, the MCNP Output Deck, and the Organ Dose panel by selecting one of
the tabs across the top. The user can also run the MCNP executable and load a previous
MCNP output deck for dose analysis using the buttons along the bottom of the panel
(Figure 6-1). The uploaded MCNP output deck must be one that PIMAL originally
generated; any other MCNP output will result in an error. PiMAL will direct the user to
select the appropriate file and will then operate on that file to generate a table of organ
doses and effective dose in the same manner as if the output had just been generated
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using PIMAL/MCNP. The user is cautioned that when loading a previously run file, a
warning will likely appear stating that the corresponding Particle Track Output (PTRAC)
file cannot be loaded, however this does not affect the loading of data and subsequent
dose calculations provided by PiIMAL.

To run MCNP, the user clicks the Run MCNP button at the bottom center of the operations
panel. While MCNP runs in the background, the output deck is continuously updated and
shown in the MCNP Output Deck tab (Figure 6-2). Until MCNP has fully completed its
execution, closing the operations panel will abort the run.

Note: If a user tries to run MCNP through PiIMAL without having an installed version
of MCNP on their computer, PIMAL will get stuck in a loop searching for the
executable. This loop can be terminated by closing the operations panel.

MCNP Input Deck MCNP Output Deck  Computed Organ Dose Values

the 1@ statistical checks are only for the tally fluctuation chart bin and do not apply to other tally bins.

warning. 1 of the 1 tally fluctuation chart bins did not pass all 18 statistical checks
warning. 1 of the 1 tallies had bins with relative errors greater than recommended.
1tally fluctuation charts

tally 216
nps mean error vov slope fom
Bsaea 4.3855E-81 @.1675 8.8538 @.8 17183

16808 4.8816E-81 8.1155 8.8238 @.8 15138
z4pe0 4.388BE-01 @.0954 8.8162 0.9 12781
3zeee 5.387@E-21 @.e589 2.0111 @.@ 13961
48808 5.8462E-81 @.8765 8.8882 4.8 14575
4zeel 5.6766E-21 @.8654 B.8072 @.0@ 14827
S6eee 5.8049E-21 @.0080 ©.0@58 @.@ 15696

64888 6.8863E-81 8.8554 9.8040 10.0 16786
72088 6.8784E-81 @.8521 9.8644 16.8 17269
seeel 6.1117E-21 @.8491 2.8030 18.0@ 18555
Boeee 6.1577E-21 @.9467 2.0035 1@.@ 19991
960888 6.B969E-81 @.8449 8.8832 160.8 28233
laaeaa 6.B6BBE-81 @.8442 B.8831 18.8 28482

dump no. 2 on file runtpo nps = 106000 coll = 19857 ctm = 8.e3 nrn =
597862
ascii file pimal_22.op written with 5BBER events

from 58288 histories.

12 warning messages so far.

run terminated when 100000 particle histories were done.
computer time = 8.84 minutes
mcnp version 6 @z/2e/18 @8/14/24 13:34:28 probid = @8/14/24 13:34:24 |

Figure 6-2 MCNP Output Deck.

If errors occur during the MCNP run, a note will be shown in a dialogue box and the MCNP
Output Deck will be updated with an error description (Figure 6-3). Select OK to continue.
Additionally, MCNP Errors/Warnings are shown in the MCNP output window (Figure 6-4).
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there are no nonzero tallies in the tally fluctuation chart bin for tally 216

1status of the statistical checks used to form confidence intervals for the mean for each tally bin

tally result of statistical checks for the tfc bin (the first check not passed is listed) and error magnitude check for all bins

216 no nonzero tallies were made in the tally fluctuation chart bin

missed all bin error check: 38 tally bins had 21 bins with zeros and 9 bins with relative errors exceeding 8.18@

the 1@ statistical checks are only for the tally fluctuation chart bin and do not apply to other tally bins.
the tally bins with zeros may or may not be correct: compare the source, cutoffs, multipliers, et cetera with the tally bins.

1 tally fluctuation chart bins did not pass all 18 statistical checks.
1 tallies had bins with relative errors greater than recommended.

warning. 1 of the
warning. 1 of the
1tally fluctuation charts

tally 216
nps mean error  vov slope  Fom
26 0.00BOE+00 0.0000 0.0088 0.9 O.OE+8D

dump no. 2 on file runtpr nps = 28 coll = 29 ctm = 8.0e nrn =
562
ascii file pimal_25.op written with 38 events

from 18 histories.

12 warning messages so far.

run terminated because 18 particles got lest.

computer time = 8.82 minutes

mcnp version 6 @2/20/18 88/14/24 13:40:20 probid = ©8/14/24 13:48:18

Figure 6-3

MCNP Input MCNP Console MCNP Output Organ Dose | MCNP Errors/Warnings

The following warnings/errors were idenvified. The user should inspect the output file for additional warnings
or indications Of an error in the MCNP simulation.
1 of the

[1] warning. 1 tallies had bins with relative errors greater than recommended.

Figure 6-4 MCNP Errors/Warnings Display.

An Example of a Lost Particle Termination Warning.

RCD-25-008-0

On completion of the MCNP run, a chart displaying Organ Doses (Figure 6-5) is created
automatically. This chart summarizes the simulation by providing the organ absorbed
dose (with modification thereof described in the next section) delivered to each of 29
organs in the selected PIMAL human phantom along with the relative standard error (as
a percentage) of the Monte Carlo calculation of organ dose. Tissue weighting factors are
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specified for organs included in the effective dose calculation for the selected ICRP
publication (ICRP 1977; ICRP 1991; ICRP 2007).

MCNP Input  MCNP Cansole  MCNP Output | O

ICNP Errors/Warnings

Activity: 1.00e+00 Bg ICRP 103 -

Organ/Cell List Photon Tally (MeV/g per Photon) Photon Relative Error (-}

Adrenals 3.10e-09 1.07e-01
Bladder 1.05e-08 3.63e-02
Bone Marrow 1.24e-08 6.70e-03
Bone Surface 1.24e-08 6.70e-03
Brain 461e-09 277e-02
Breast 1.24e-08 .81e-0;
Colon 7.34e-09 .11e-0:
Esophagus 5.18e-09 4.55e-0
Extrathoracic Region 7.34e-09 .02e-0:
Eyes 1.31e-08 7.25e-0
G 9.15e-09 6.05e-02
Heart 1.24e-08 253e-02
Kidneys 3.38e-09 4.19e-02
Liver 7.98e-09 1.87e-02
Lower Large Intestine Je-0! . 10e-0:
Lunas 1e-0! .68e-02
Lymph Nodes 5e-01 .61e-0
Muscle 1e-0! 4.00e-0
Oral Mucosa 6.83e-09 .52e-0:
Ovaries 5.89e-09 9.65e-02
Pancreas 6.27e-09 4.12e-02
Salivary Glands 6.46e-09 5.26e-02
Skin 1.25e-08 4.20e-03
|Small Intestine 94e-09 2.20e-0:
|Spleen 71e-0 5.16e-0
|Stomach §8e-0 2.77e-0.
|Thymus 22e-0 .78e-0:
Thyroid 22e-0 .17 e-0:
Upper Large Intestine 7.94e-09 2.70e-02
Uterus 6.02e-09 6.07e-02

Export to CSV Effective Dose (Sv):  5.34e-15

Figure 6-5 Organ Doses.
6.2 Calculation of Organ Dose

After running MCNP, in addition to displaying the output deck, PIMAL parses the output
(F6 tallies) and creates a listing of the tallied organ absorbed doses. MCNP calculates
the mass of the target organ using the cell volume(s) and material density that define the
organ. The average energy deposited per unit mass in the named organ is calculated
using the MCNP FG6 tally.

Absorbed Dose Calculation. Organ dose is calculated differently for each of three
source types as chosen by the user: (1) a source radionuclide; (2) an X-ray tube emission
spectrum; or (3) a neutron (a,n) reaction source. In the first case, the user selects a
specific radionuclide and is then asked to enter the nuclide activity, A4,, and
exposure/residence time, t. Exposure time is meant for external sources, and residence
time is a special intake case for an internal calculation with biological clearance of the
radionuclide as a source colloid or fragment that neither dissolves in the body nor enters
the blood stream. Radionuclide uptake into the blood stream and systemic distribution
throughout the body with retention in different body compartments are not considered by
PIMAL because internal dosimetric models and coefficients are widely available for that
purpose. Residence time should be calculated using only the biological loss rate
constant, 4,, such that:
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Tp[s] = o] [6.1]

The user is responsible for estimating the biological residence time (not considering
radiological loss). Absorbed dose to organ i, D;, is calculated for radionuclides using:

Dil6y] = F6[MV /g |+ Alne] = P[] + 160221070 [ 9/ 1y ] [6.2]

where
F6 = the organ F6 tally returned from MCNP (MeV/g per source particle);
A= integrated activity (i.e., total number of nuclear transitions); and
P = probability of photon emission (all energies) per nuclear transition.
Integrated activity is calculated from:

7 ! 1—e At
Afnt] = ] Age~et dt = A, (T> [6.3]
(0] e

with 4, representing the sum of rate constants for radioactive (4,.) and biological loss (4,).
For an internal source, the integration time is assumed to be infinite. For sources external
to the body, 1, is assumed to equal zero, so that the integration time is equal to the
exposure time.

For X-ray sources the user will enter X-ray tube exposure factors including tube voltage
(kVp), tube current (mA), and tube energized time, t. From these inputs, PIMAL will
predict external dose to the receptor organs (D;) assuming uniform exposure:

1‘;‘3:] ol [m_C] v tls] * e[ /-] * 1.602x10° ]‘g—e_] [6.4]

DilGy] = F6 [ MeV kg mC

S

Tube current, I, multiplied by time (i.e., total flowing charge) is sometimes represented as
‘mAs”, and a tube efficiency, ¢, of 1% is assumed for all calculations in PIMAL. More
details on X-ray tubes and their operation can be found in Bushong (2008).

As an example, the X-ray tube photon emissions for an operating peak voltage of 100
kVp (Radiopaedia 2024) results in an energy distribution from near zero to 100 keV
(Figure 6-6). The continuous portion of the distribution is the result of bremsstrahlung
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photon emissions, and the four peaks are due to characteristic X-rays emitted by the
representative target material.

100 kVp X-ray Source

Relative Probability

0.04 0.05 0.06 0.07 0.08 0.09

Photon Energy (MeV)

Figure 6-6 X-ray Energy Spectrum from a Tungsten Target Operated at 100
kVp.

For neutron sources no additional scenario data are requested of the user. In this case,
the organ dose results (MCNP F6 tally) are presented as dose per emitted neutron [Gy/n]
however defined in the scenario.

Calculation of Effective Dose. Once the MCNP run has finished, the organ dose values
are displayed on the 4™ tab, entitled “Organ Doses” (see Figure 6-5). MCNP generates
values for the F6 tally in MeV/g per source particle for the selected exposure scenario,
with organ absorbed dose then calculated as described above.

Effective dose (E) is then calculated as the sum of organ-specific absorbed dose (D;) over

all organs i, multiplied by appropriate weighting factors (as specified by the selected ICRP
reference), using:

Elsvl =w,.+ > DilGy] = w, [6.5]

assuming a radiation weight factor (w,) of unity (1) for photons and tissue weighting
factors (w;,) from either ICRP 26 (1977), ICRP 60 (1991), or ICRP 103 (2007) (Table 6-1).

Because of the varied definition of radiation weighting factors for neutrons (by energy),
and because organ dose by original incident neutron energy is not tracked in MCNP, an
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effective dose calculation for neutrons is not possible. It is for this reason that neutron
dose by organ remains in units of absorbed dose (e.g., Gy) per source particle. Thus, the
present version of PIMAL does not calculate effective doses from neutron sources.

Table 6-1

Tissue, i
Bladder

Red bone marrow

Bone surfaces
Brain

Breast

Colon
Esophagus
Gonads

Liver

Lung

Salivary glands
Skin

Stomach
Thyroid
Subtotal

Remainder

Total

ICRP 26

0.12
0.03

0.15

0.25

0.12

0.03
0.70

0.30
1.00

ICRP 60

0.05
0.12
0.01

0.05
0.12
0.05
0.20
0.05
0.12

0.01
0.12
0.05
0.95

0.05
1.00

ICRP 103

0.04
0.12
0.01
0.01
0.12
0.12
0.04
0.08
0.04
0.12
0.01
0.01
0.12
0.04
0.88

0.12
1.00

Tissue Weight Factors for the ICRP 26, 60, and 103 Dosimetry
Methods.

In ICRP 26 (1977), the remainder tissue weighting factor has a collective value of 0.30.
This remainder weight is applied to the average of the five highest organ doses that are
not explicit in the ICRP 26 subtotal column of Table 6-1. The skin and lens of the eye are
not included in the remainder tissue calculation. ICRP 60 (1991) states that a weight of
0.05 is given to the average of all remaining organ doses, listing ten organs explicitly to
compose the remainder (see Table 6-2). A caveat for the handling of remainder weights
in ICRP 60 is that if the highest remainder organ dose is greater than any others, it
receives a weight of 0.025 and another 0.025 goes to the average of the remaining
organs. And, in ICRP 103 (2007), the remainder weighting factor is increased to 0.12
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and should be averaged over the remaining organs as listed in Table 6-2. These rules
have been implemented in the PIMAL calculation of effective dose.

Table 6-2 Remainder Organs Listed in the ICRP 60 and 103 Dosimetry
Methods.

Tissue ICRP 60 ICRP 103
Adrenals X X
Brain X
Extrathoracic
Gall bladder
Heart
Kidneys X
Lymph nodes
Muscle X
Oral mucosa
Pancreas X
Prostate or Uterus
Small intestine

Spleen

X X X X X X X X X X X X

X
X
Thymus X
X

Upper large intestine

PiMAL gives the user the opportunity to select one of three sets of ICRP tissue weighting
factors (ICRP 26, 60, or 103) to calculate effective dose. A dropdown window is provided
in the upper right corner of the Organ Dose tab. On selection of a new set of tissue-
weighting-factors, the Effective Dose value (lower right corner) will repopulate. The F6
tally chart can be exported as a .csv file by clicking the Export to CSV button at the bottom
center of the organ dose window.
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7 PHANTOM DESCRIPTIONS

This section contains a description of the cells and the surfaces that make up the
components for phantoms modeled in PIMAL. Material definitions and tally descriptions
are also provided. The phantoms available in PiIMAL include: (1) human female; (2)
human male; (3) dog; (4) cat; and (5) horse.

7.1 Human Phantoms

The human phantoms are subdivided into the following component parts of: (1) head and
neck; (2) chest; (3) arms; and (4) legs. A pictorial representation of the phantoms is
provided in Figure 7-1. The following subsections will provide a detailed description of the
human phantoms.

The numbering of cells in the MCNP input deck is maintained between the male and
female phantoms. This means that for each of the human phantoms, each organ will have
the same number regardless of the phantom’s sex. The sex-related organs are similarly
numbered but will be in different locations with different parameters and sometimes
material. For example, the uterus and the prostate share a cell number between the
phantoms but will be defined by surfaces (and have a different volume and material
definition) according to the differences between those organs. This is not true of the
surfaces used for the organs between the phantoms; surface numbering and parameters
will be different between the two sexes.

The following notes apply to both male and female phantoms:

o The material compositions for each component (e.g., heart, lung, etc.) are based
on ICRP 89 (2002);

o The density (specific gravity) for each component is based on ICRP 110 (2009);

o The shapes, placement, and subsequently, the volume of each component is
determined using basic anatomical knowledge of each organ and has been
documented in original literature (Akkurt and Eckerman 2007). The volume of each
organ is estimated based on the surfaces used in MCNP, and MCNP computes
the mass based on the volume and the density of the simulated organ; and

o Phantoms are based on representative adult male and female values. They do not
account for age or weight variation.

Due to the approximation in geometric models of the phantom, it is recognized that
resulting calculated volumes may not be exact. The mass of the organ is not necessarily
that of the true organ, but rather the mass based on the volume the organ occupies in the
mathematical phantom. Since the human phantoms are the targets of interest for
determining dose results, it is more important for the density to be correct (ratio of mass
to volume) so that organ dose values are correct.
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Figure 7-1 Human Female (left) and Human Male (right) Phantom.

This section provides details of the human phantom including: (1) the MCNP cells that
make up its components; (2) component material number; (3) component volume; (4)
assumed density; and (5) resulting component mass. The male and female phantoms
are very similar except for sex-specific organs, relative organ size, and total mass. This
section focuses on the female phantom with much of the narrative applying to both
phantoms. Specifics that do not appear here can be found in the generated MCNP input
deck.
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R .

Figure 7-2 2D Female Phantom Head and Neck Diagram (cell numbers shown).
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Table 7-1 Female Phantom Head and Neck Component Definitions.
Cell Component Material V(ocl :]r;;e ?&22?)’ Mass (g)
1 Skin of Head/Neck 11 214.8 1.09 234
5 Nasal Cavity 5 2131 1.22 260
6 Brain 6 1310.2 1.04 1360
7 Left Eye 7 6.2 1.07 6.63
8 Right Eye 7 6.2 1.07 6.63
9 Total Sinuses 4 33.1 0.001205 0.0399
10 Pharynx Residual Wall 13 9.71 1.05 10.2
11 Pharynx Contents 4 23.2 0.001205 0.0280
12 Pharynx Mucosa Wall 13 5.41 1.05 5.68
13 Larynx Residual Wall 8 2.53 1.1 2.78
14 Larynx Content 4 3.97 0.001205 0.00478
15 Larynx Mucosa Wall 8 1.35 1.1 1.49
16 Trachea Residual Wall 9 8.67 1.03 8.93
17 Trachea Contents 4 12.8 0.001205 0.0154
18 Trachea Mucosa Wall 12 1.9 1.03 1.96
19 Thyroid 10 11.9 1.05 12.5
20 Nose Contents 4 4.8 0.001205 .00578
21 Nose Wall 13 6.9 1.05 7.25
22 Oral Cavity 12 231.6 1.03 239
23 Salivary glands 12 65.4 1.03 67.4
24 Muscle of Head and 13 1119.9 1.05 1180
Neck

The next set of organs described will be those of the axial skeleton (Figure 7-3).
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Figure 7-3

Table 7-2 Female Phantom Axial Skeleton Component Definitions.

3D Axial Skeleton.

RCD-25-008-0

, Volume Density Phantom
Cell Component | Material (cm?) (g/cm?) Mass (g)
2 Cranium 2 284.5 1.40 398
3 Teeth 2 30.2 1.40 42.3
4 Mandible 2 144.8 1.40 203
Cervical
25 Vertebrae 2 130.6 1.40 183
Thoracic
26 Vertebrae 2 418.9 1.40 586
Lumbar
27 Vertebrae 157.26 1.40 220
28 Ribs 2 531 1.40 743

Following the axial skeleton is the following descriptions of the appendicular skeleton.
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Table 7-3 Female Phantom Appendicular Skeleton Component Definitions.

Cell Component | Material V(erl:]g])e I(Dg;grsr:?)/ I:Ar;asr;t(()g;
29 Clavicles 2 41.6 1.40 58.2
30 Scapulae 2 154 1.40 216
31 Pelvis 2 460 1.40 644
85 R Arm 2 434 1.40 608
97 L Arm 2 434 1.40 608
109 R Leg 2 1213 1.40 1700
125 L Leg 2 1213 1.40 1700

All cells in Table 7-2 and Table 7-3 are included in the estimation of dose to the bone
surface, whereas only cells 25 through 31 are included in the estimation of dose to the
red bone marrow.

The chest organs (Figure 7-4) are arranged in the female phantom as follows.
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Figure 7-4 Chest Organs of the Female Phantom.
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Table 7-4 Female Phantom Chest Organ Component Definitions.
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Cell Component Material V(Ocl rLT‘]r:P)e I(Dge/grsr,:g))/ I;Ar;ir;t(()g;
32 ikl 12 9.827 1.03 10.1
33 mam Sroner! 12 10.8 1.03 11.1
34 M?:i“ Bronchi 4 2.403 0.001205 | 0.00290
ontents
35 Left Lung 14 1020 0.26 265
36 Right Lung 14 1180 0.26 307
37 Thymus 12 32.725 1.03 33.7
38 Heart Wall 15 231 1.05 243
39 Heart Contents 1 334 1.04 347

The following images and tables describe the abdominal organs (Figure 7-5).
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Figure 7-5 Abdominal Organs of the Female Phantom.

7-8



RCD-25-008-0

Table 7-5 Female Phantom Abdominal Organ Component Definitions.

, Volume Density Phantom
Cell Component Material (cm?) (g/cm?) Mass (q)
40 Left Adrenal 12 5.05 1.03 5.20
41 Right Adrenal 12 5.05 1.03 5.20
42 Left Kidney 16 119.2 1.04 124
43 Right Kidney 16 119.2 1.04 124
44 Liver 17 1350 1.05 1420
45 Gall Bladder 12 7.616 1.03 7.84
Wall
46 Gall Bladder 12 47 1 1.03 48.5
Contents
47 Pancreas 18 98.93 1.04 103
48 Spleen 19 119 1.06 126
Urinary Bladder
75 Mucosal Wall 21 5.33 1.04 5.54
Urinary Bladder
76 Remainder Wall 21 29.16 1.04 30.3
27 Urinary Bladder 3 154 10 154
Contents

83 Trunk Muscle 12 24297 1.03 25000
84 Trunk Skin 11 958 1.09 1040

The components of the female gastrointestinal phantom are provided in Table 7-6.
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Table 7-6 Female Phantom Gastrointestinal Component Definitions.
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. Volume Density Phantom

Cell | Component Material (cm?) (g/cm?) Mass (q)

49 \'f\f;f’hagus Mucosal 12 5.25 1.03 5.41

51 | Esophagus Remainder | ,, 26.48 1.03 27.3
Wall

52 Esophagus Contents 3 7.07 1.00 7.07

53 Stomach Mucosal Wall 20 39.38 1.03 40.6

54 Stomach Remainder 20 73 6 103 75 8
Wall

55 Stomach Contents 3 187 1.0 187

56 Small Intestine 20 806 1.03 830
Ascending Colon

57 Mucosal Wall 20 16.9 1.03 17.4
Ascending Colon

58 Remainder Wall 20 52.59 1.03 542

59 | Ascending Colon 3 73.4 1.0 73.4
Contents
Proximal Transverse

60 Colon Mucosal Wall 20 11.33 1.03 11.7
Proximal Transverse

61 Colon Remainder Wall 20 34.8 1.03 35.8
Proximal Transverse

62 Colon Contents 3 48 1.0 48
Distal Transverse

63 Colon Mucosal Wall 20 1.3 1.03 11.6
Distal Transverse

64 Colon Remainder Wall 20 34.8 1.03 35.8
Distal Transverse

65 Colon Contents 3 48 1.0 48

ee | Descending Colon 20 16.7 1.03 17.2
Mucosal Wall
Descending Colon

67 Remainder Wall 20 49.8 1.03 51.3

gg | Descending Colon 3 58.03 1.0 58.9
Contents

69 \?&gwo'd Colon Mucosal | 5 9.10 1.03 9.37
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Table 7-7 Female Phantom Gastrointestinal Component Definitions (Cont.)
. Volume Density Phantom

Cell | Component Material (cm?) (g/cm?) Mass (q)
Sigmoid Colon

70 Remainder Wall 20 28.3 1.03 29.1

71 | Sigmoid Colon 3 37.5 1.0 37.5
Contents

72 Rectum Mucosal Wall 20 3.85 1.03 3.97

73 | Rectum Remainder 20 10.93 1.03 113
Wall

74 Rectum Contents 3 36.51 1.0 36.51

Female sex organs, which include the ovaries and uterus, are shown below (Figure 7-6).

Figure 7-6

Female Sex Organs.

’ 1

And male sex organs, which include the testes and prostate, are shown in Figure 7-7.
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Sex-specific organs include the reproductive organs, as figured above, and the breasts.
While both males and females have breast organs, the size of the organ differs from male
to female. The volumes and masses of those organs are differentiated in Table 7-8.

Table 7-8 Sex-Specific Organ Component Definitions.

Female Male Density
Cell Component Material | Volume Volume 3 Mass (g)
3 3 (g/cm?)
(cm°) (cm°)
78 Left Ovary 23 5.05 1.05 5.30
79 Right Ovary 23 5.05 1.05 5.30
78 Left Testes 22 18.8 1.04 19.6
79 Right Testes 22 18.8 1.04 19.6
80 Uterus 24 76 1.02 77.5
80 Prostate 12 15.3 1.03 15.8
81 Left Breast 25 235.9 0.94 222
82 Right Breast 25 235.9 0.94 222
81 Left Breast 25 0.94 76.2
82 Right Breast 25 0.94 76.2

Additionally, for completeness, lymph nodes are specified as cells 142-147.

7.2 Animal Phantoms

The generalized animal phantom is shown in Figure 7-8. This provides locations of

various cells (organs) as listed in
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Table 7-9. The phantom is scaled by mass (Section 7.3) from a small cat, through the
dog, to a large horse to maintain the general placement of organs. Animal phantoms
differ in snout size, neck length, thyroid placement, and leg length, but are otherwise
based on the same general model.

Figure 7-8 2D Center-Line Cross Section of Companion Animal.
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Table 7-9 Animal Parameter Values of Volume, Density, and Mass.

Cell Component Material V(ocl :"};e I()gelgrsr:?), Mass (g)
200 Ribs 2 1649 1.4 2310
201 Skin 11 4400 1.09 4800
202 Abggar';za' 12 5562 1.03 5730
203 Neck 12 1800 1.03 1850
204 Spine 2 1455 1.4 2040
205 Thyroid 10 30 1.05 315
206 Skull 2 249 1.4 349
207 Brain 6 1128 1.04 1170
208 Face 12 1500 1.03 1550
209 Jaw 2 369 1.4 517
210 Eyes 7 8.4 1.07 8.99
21 L Humerus 2 102 1.4 143
212 L Scapula 2 102 1.4 143
213 F';)Fe?irr‘g’b 2 14 1.4 19.6
236 2 100 1.4 140
237 2 14 1.4 19.6
238 2 77 1.4 108
214 | L ST Forelimb 13 134 1.05 141
239 13 19 1.05 20.0
240 13 103 1.05 108
241 13 19 1.05 19.95
215 | R Humerus 2 102 1.4 142.8
216 R Scapula 2 102 1.4 142.8

7-14



RCD-25-008-0

Table 7-9 Animal Parameter Values of Volume, Density, and Mass (Cont.).

Cell Component Material V(ocl :"};e I()gelgrsr:?), Mass (g)
217 Fizﬁ;yb 2 14 14 19.6
242 2 100 1.4 140
243 2 14 1.4 19.6
244 2 77 1.4 108
218 FoﬁeslirTnb 13 134 1.05 141
245 13 19 1.05 20.0
246 13 103 1.05 108
247 13 19 1.05 20.0
219 Lungs 14 2500 0.26 650
220 Heart 15 375 1.05 394
221 Liver 17 1000 1.05 1050
222 Stomach 20 1000 1.03 1030
223 Intestines 20 2000 1.03 2060
224 Kidneys 16 255 1.05 268
226 glgg‘;reyr 21 300 1.04 312
227 Uterus 24 300 1.02 306
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Table 7-9 Animal Parameter Values of Volume, Density, and Mass (Cont.).

. Volume Density
Cell Component Material (cm?) (glcm?) Mass (g)
228 R femur 2 106 1.4 148
R pelvic 2
229 Hemisphere 87 1.4 122
230 R femur 2 14 1.4 19.6
R pelvic 2
248 | Hemisphere 11 14 155
249 2 14 1.4 19.6
250 2 77 1.4 108
231 13 22 1.05 23.1
251 13 175 1.05 184
252 13 22 1.05 23.1
R ST 13
253 | Hindlimb 121 1.05 127
232 L femur 2 106 1.4 148
L Pelvic 2
233 Hemisphere 87 1.4 122
L Bony 2
234 Hindlimb 14 14 19.6
254 2 111 1.4 155
255 2 14 1.4 19.6
256 2 77 1.4 108
235 13 22 1.05 23.1
257 13 175 1.05 184
258 13 22 1.05 23.1
259 | L ST Hindlimb 13 121 1.05 127

7.3 Animal Scaling

PIMAL 6.0 allows the user to select cat, dog, or horse and then specify the mass of the
animal. These selections build a scaled volume representing total mass of that animal
type. Generally, the volume parameters correspond mathematically with the computed
volume in expected geometric ways that follow an approximate third power rule (Figure
7-9 and Figure 7-10). The relationship was developed by aggregating data from various
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sources on cat, dog, and horse conformation (Zink 2020; Serpell 2017; Ross 2017;
Duberstein 2016; Jorg 2019).

Animal Length vs Mass
(cat, dog, and horse)
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Figure 7-9 Animal Length as a Function of Animal Mass.
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Figure 7-10 Animal Girth as a Function of Animal Mass.

The parameters for the curve fit show that the relationship between mass and length (as
well as mass and girth) maintains a similar power function. The animal length vs mass
relationship (length = 20.3 * mass®32%) was used to scale the companion animal from
0.5 kg through 1,500 kg. Because the volumes in the MCNP file are generated based on
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intersections of various geometric shapes (i.e., radii are not defined for the body length,
rather as sections with a total of a specified length), the relationship above is applied as
a ratio rather than to solve for individual volume lengths. For example, the total body
length corresponding to a 30 kg animal is 62.2 cm:

L(30 kg) = 20.3 x30°32% = 62.2 cm [7.1]

This is used as the baseline length to scale all other length parameters in the MCNP file.
Given that the total length of a 40 kg animal is,

L(40 kg) = 20.3 = 40°32% = 68.3 cm [7.2]

the proportion of this to the baseline is 68.3/62.2 = 1.10. Similarly, a 10 kg animal would
have a total length of,

L(10 kg) = 20.3 x 10°32% = 433 cm [7.3]

corresponding to a proportion of 0.696. This ratio, for example, is applied to all length
parameters in the MCNP base file to scale the animal's length according to the mass
input. Using this technique, each of the internal organs will retain body mass ratio of each
animal. Morphometrics generally suggests that critical organs follow a proportionality with
the total mass of the animal; for example, a liver is generally about 2.2 percent of the total
body mass (Ross 2018). For this reason, scaling the animal by total mass will generally
retain an accurate representation of the mass, and thus volume, of each animal organ.

Because there is inter-species variation between PIMAL animals in the limb, neck and
head/face parameters, simple scaling between the three animals for these parameters is
not appropriate. The user, therefore, selects the appropriate animal and the resulting
phantom will reflect these variations. Since the differences in scaling between animals is
limited to skeletal features (i.e., legs, neck, face), all organ volumes representing sources
used for radiation dose calculations are excluded from this interspecies variation, but the
locations of the organs will be more accurate based on the height of the animal.

Given the large intra-species variation for each of the PIMAL animals, no phantom will be
exactly representative of any particular companion animal. However, as a general rule
(Zink and Schlehr 2020; Duberstein 2016) both dogs and horses are square in that the
length of the body is equal to the height of the animal at the withers, and that both dogs
and horses have leg lengths that are approximately equal to one-half their height (Figure
7-11). The values used to calculate the base line proportion discrepancies for the three
listed species were found using the information in horse and dog conformation references
(Zink and Schlehr 2020; Duberstein 2016) and cat-breed size estimates. Neck lengths for
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horses are found in conformation references, and the length of the dog’s neck has been
scaled from baseline spine-length measurements of 30 kg dogs (Miller 2012).

Figure 7-11 Demonstration of Body Length and Height Relationship.

There is a difference, however, in horse and dog location of the knee joint (Zink 2020;
Mostafa 2020). For this reason, an average is set to represent the likely location of
important joints (in the dog and horse, the knee joint is a critical source location for
radiotherapy treatments), and in the case of the dog, skews the square body rule slightly
for that critical anatomical feature to be represented in the animal. Table 7-10 provides
specific scaling factors in the face, neck, and limbs of the three animals phantoms.

Table 7-10 Data Used to Relate Skeletal Differences Between Animal

Phantoms.
Cat Dog Horse
Face sphere ovoid ovoid

1% Spine Length

20% Spine length

33% neck length

Neck 20% Spine Length 30% spine length 50% spine length
Lower Leg | 50% upper leg 90% upper leg 100% upper leg
Upper leg 25% spine length 25% spine length 25% spine length
Height 60% spine Length 100% Spine Length 100% Spine Length

It is important to note that these values are approximations based on horse, dog and cat
conformation and body size distributions, and not representative of a particular breed or
size of animal. The location of major organs and ratios of those organs to the mass of the
animal are maintained so that volumes and locations can be preserved based on the
mass of the animal alone, and do not need to be modified from one animal phantom to
the other. In the same way, the elemental composition and density of the organs
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themselves are maintained through all species (companion animals and humans) to
maintain MCNP phantom compatibility.
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8 STANDARD POSITIONAL RELATIONSHIPS

With v6.0, PIMAL has the capability of pairing a human and animal in the same Monte
Carlo universe. This allows the user to model the radiation dose to humans from medically
applied radioactivity in a companion animal (i.e., cat, dog, horse). For this pairing, only
one human and one animal can be in the same universe. Various relationships between
human and animal phantoms have been developed to assist the user in a quick initial
positioning (Table 8-1 through Table 8-6). The human is always centered on (0, 0, 0) and
the animal is moved in relation to the human.

8.1 Cat Placement

8.1.1 Cat in the Lap of a Human Female

Table 8-1 5 kg Cat Placement with Respect to the Human Female.
Human Female Articulation | placement 5 kg Cat Location/Joint placement
R Shoulder X Rotation 0 Base X Location -9
Y Rotation 0 Y Location -25
R Elbow X Rotation 0 Z Location 17
Y Rotation 0 Z Rotation 0
L Shoulder X Rotation 0 L Fore Knee Y Rotation -40
Y Rotation 0 L Fore Ankle Y Rotation 150
L Elbow X Rotation 0 R Fore Knee Y Rotation -40
Y Rotation 0 R Fore Ankle Y Rotation 150
R Hip X Rotation -80 L Hind Knee Y Rotation -40
Y Rotation 0 L Hind Ankle Y Rotation 125
R Knee X Rotation 90 R Hind Knee Y Rotation -40
Y Rotation 0 R Hind Ankle Y Rotation 125
L Hip X Rotation -80
Y Rotation 0
L Knee X Rotation 90
Y Rotation 0

8.1.2 Cat sleeping on the chest of a Human Male

Table 8-2 3 kg Cat Placement with Respect to the Human Male.

5 kg Cat Location/Joint on chest
Base X Location 5
Y Location -20
Z Location 45
Z Rotation 0
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8.2 Dog Placement

8.2.1 Dog at the Feet and Walking with Human Male

Table 8-3 30 kg Dog Placement with Respect to the Human Male.

Location Articulation at the feet | walking beside
Base X Location 5 40
Y Location -25 10
Z Location -28 -28
Z Rotation 0 90

8.2.2 Dog in the Lap of a Human

RCD-25-008-0

Table 8-4 10 kg Dog Placement with Respect to the Human Female.
Human Female Articulation | placement 10 kg Dog Location/Joint placement
R Shoulder X Rotation 0 Base X Location -9
Y Rotation 0 Y Location -25
R Elbow X Rotation 0 Z Location 21
Y Rotation 0 Z Rotation 0
L Shoulder X Rotation 0 L Fore Knee Y Rotation -40
Y Rotation 0 L Fore Ankle Y Rotation 150
L Elbow X Rotation 0 R Fore Knee Y Rotation -40
Y Rotation 0 R Fore Ankle Y Rotation 150
R Hip X Rotation -80 L Hind Knee Y Rotation -40
Y Rotation 0 L Hind Ankle Y Rotation 125
R Knee X Rotation 90 R Hind Knee Y Rotation -40
Y Rotation 0 R Hind Ankle Y Rotation 125
L Hip X Rotation -80
Y Rotation 0
L Knee X Rotation 90
Y Rotation 0
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8.3 Horse Placement
8.3.1 Human Grooming and Leading a Horse

Table 8-5 300 kg Horse Placement with Respect to the Human Female.

Location Articulation grooming leading
Base X Location 10 0
Y Location -65 200
Z Location 30 30
Z Rotation 0 90

8.3.2 Human Riding a Horse

Table 8-6 Human Female Placement with Respect to 300 kg Horse.

Human Female Articulation | placement | 300 kg Horse | Location/Joint placement
R Shoulder X Rotation -30 Base X Location 0
Y Rotation 0 Y Location -15
R Elbow X Rotation -30 Z Location -45
Y Rotation 0 Z Rotation 90
L Shoulder X Rotation -30 L Fore Knee Y Rotation 0
Y Rotation 0 L Fore Ankle Y Rotation 0
L Elbow X Rotation -30 R Fore Knee Y Rotation 0
Y Rotation 0 R Fore Ankle Y Rotation 0
R Hip X Rotation -60 L Hind Knee Y Rotation 0
Y Rotation 50 L Hind Ankle Y Rotation 0
R Knee X Rotation 60 R Hind Knee Y Rotation 0
Y Rotation 0 R Hind Ankle Y Rotation 0
L Hip X Rotation -60
Y Rotation -50
L Knee X Rotation 60
Y Rotation 0
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9 BENCHMARKING THE EFFECTIVE DOSE CALCULATION

The effective dose (using ICRP 60 tissue weighting factors) to a female is calculated for
an exposure of 1.5 hours (1) at 1.5 meters from the chest to a 1 GBq (4,), Sn-117m point
source (Figure 9-1). The source is external to the body (i.e., no biological loss), therefore
the effective loss constant (1,) only considers physical decay and has a value of 5.90E-
07 [s™] (half-life of 13.6 days).

Phantorn  View Preferences Help

Camera Controls Human Female
Simulation Material Visibility
Source Sn-117m ~

Configuration Point Source (Internal) ~

Source Position

Activity 1E9 Bq

Residence Time hr

Generate MCNP Input

Save Image Reset

Figure 9-1 Simulation Panel Showing Location of the Sn-117m Point Source.

The total number of transitions (4) occurring during the 1.5-hour exposure is equal to:

1 — ¢~ (5.90x1077+5400)

5.90x10~7 [s~1]

A= 1x109< ) = 5.39x10'2 [nt] [9.1]
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With one-million simulated particles, an MCNP F6 output of 1.32x108 [MeV/g ] for the
thyroid, a radiation weighting factor (wr) of 1 [Sv/Gy], and a probability of photon emission
(P) of 1.552 [y/nt], the thyroid organ equivalent dose (H;) is:

MeV Sv
H; = 1.32x1078 [ ] x1 [—] % 5.39x10"2[nt] * 1.552["/,4]
gy Gy ; [9.2]
-10 g ] — -5
*1.602x1071 | =2 o 1.77x1075 [Sv]

With effective dose calculated the ICRP 60 (1991) list of organs and the five highest
remainder organs, the effective dose can be estimated. The effective dose (E) is the sum
of all organ-specific equivalent dose (H;) multiplied by their respective tissue weight
factor. As an example, PIMAL reports organ absorbed dose per source photon (F6 tally)
as shown in Table 9-1 with an effective dose calculation using the ICRP 60 method.

Table 9-1 Pertinent Data from ICRP 60.

Organ, i Wr,i F6; (MeV/gy) HE;vV;T’i
Bladder 0.05 1.51E-08 1.01E-06
Bone Marrow 0.12 1.17E-08 1.88E-06
Bone Surface 0.01 1.73E-08 2.32E-07
Breast 0.05 1.85E-08 1.24E-06
Colon 0.12 1.01E-08 1.62E-06
Esophagus 0.05 6.93E-09 4.64E-07
Ovaries 0.20 1.21E-08 3.24E-06
Liver 0.05 1.21E-08 8.11E-07
Lung 0.12 1.01E-08 1.11E-06
Skin 0.01 1.75E-08 2.35E-07
Stomach 0.12 1.23E-08 1.98E-06
Thyroid 0.05 1.32E-08 8.85E-07
Remainder* 0.05 8.65E-09 6.44E-08
Effective Dose E (sv) = 1.58E-05

*average of the nine named (Table 6-2) remainder organ doses

The effective dose estimated above is 1.58x10° Sv, starting with the various F6 tallies
and following through with a hand calculation. The PiIMAL code calculates the effective
dose to be 1.61E° Sv (Figure 9-2).
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MCNP Input MCNP Console MCNP Qutput Organ Dose  MCNP ErrorspWiarnings

Activity: 1.00e+09 Bq ICRPED......J v

OrganjCell List Photon Tally (MeV/g per Photon) Photon Relative Error ()
Adrenals 208e-09 321e-01

Bone Marrow
Extrathoracic Region
Gallbladder
Kidneys
Lower Large Intestine

Lymph Nodes
Oral Hucosa
Pancreas
Stin
Spleen
Thyrmus
Upper Large Intestine

| Export to CSY ‘ Effective Dose (5v):  1.61e-05

Figure 9-2 Organ Dose Output Window for the ICRP 60 EDE Methodology.
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Appendix A MCNP Source Data

Nuclide emissions data are from ICRP 107 with yield greater than 1% and energy greater
than 10 keV.

4.17E-09 inv sec

C ===== C0-60 Energies
SIM0 L 1.17323 1.33249
C ===== Co0-60 Probabilities

SP10 D 0.999 1.000

1.06E-08 inv sec

C ===== Cs-134 Energies

SI10 L 0.475365 0.563246 0.569331 0.604721
0.795864 0.801953 1.167970 1.365190

C ===== Cs-134 Probabilities

SP10 D 0.0149 0.0835 0.1540 0.9760

0.8550 0.0869 0.0179 0.0301

7.28E-10 inv sec
C ===== Cs-137 Energies
SIM0 L 0.0318187 0.0322056 0.0363167 0.036392 0.0372607 0.661657

C ===== Cs-137 Probabilities
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SP10 D 0.0204 0.0375 0.00358 0.00694 0.00148 0.846

1.09E-07 inv sec

C =====1r-192 Energies

SI10 L 0.011101 0.061642 0.063189 0.065302 0.067048
0.205794 0.295957 0.308455 0.316506 0.468069 0.484575
0.588581 0.604411 0.612462

C =====Ir-192 Probabilities

SP10 D 0.0135 0.0124 0.0213 0.0268 0.0458
0.0334 0.2870 0.2970 0.8270 0.4780 0.0319

0.0452 0.0820 0.0534

1.00E-07 inv sec

SP10 D 0.0140 0.0259 0.0262 0.0614 0.817 0.0717 0.0177

1.21E-06 inv sec
C ===== Lu-177 Energies

SI10 L 0.054719 0.055924 0.112950 0.208366
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C ===== Lu-177 Probabilities

SP10 D 0.0163 0.0285 0.0640 0.1100

5.90e-07 inv sec

C =====Sn-117m Energies

SI10 L 0.025023 0.025257 0.028431 0.028474

0.029088 0.156020 0.158560

C ===== Sn-117m Probabilities

SP10 D 0.1940 0.3630 0.0328 0.0636

0.0131 0.0211 0.8640

C ==== XRay Tube Voltage 60 kVp, Source Energies

SI10 H 0.0125 0.0130 0.0135 0.0140 0.0145 0.0150

0.0155

0.0185

0.0215

0.0245

0.0275

0.0305

0.0335

0.0365

0.0395

0.0160 0.0165 0.0170 0.0175 0.0180

0.0190 0.0195 0.0200 0.0205 0.0210

0.0220 0.0225 0.0230 0.0235 0.0240

0.0250 0.0255 0.0260 0.0265 0.0270

0.0280 0.0285 0.0290 0.0295 0.0300

0.0310 0.0315 0.0320 0.0325 0.0330

0.0340 0.0345 0.0350 0.0355 0.0360

0.0370 0.0375 0.0380 0.0385 0.0390

0.0400 0.0405 0.0410 0.0415 0.0420
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0.0425

0.0455

0.0485

0.0515

0.0545

0.0575

0.0430 0.0435 0.0440 0.0445 0.0450

0.0460 0.0465 0.0470 0.0475 0.0480

0.0490 0.0495 0.0500 0.0505 0.0510

0.0520 0.0525 0.0530 0.0535 0.0540

0.0550 0.0555 0.0560 0.0565 0.0570

0.0580 0.0585 0.0590 0.0595 0.0600

C ==== XRay Tube Voltage 60 kVp, Source Probabilities

SP10 D 0.0000 0.0000 0.0001 0.0003 0.0007 0.0016

0.0033

0.0580

0.2432

0.5154

0.7611

0.9260

0.9942

0.9875

0.9275

0.8299

0.7081

0.5711

0.4249

0.2745

0.1238

0.0062 0.0108 0.0179 0.0277 0.0409

0.0790 0.1045 0.1338 0.1662 0.2041

0.2864 0.3304 0.3771 0.4216 0.4709

0.5583 0.6041 0.6469 0.6857 0.7259

0.7975 0.8272 0.8576 0.8802 0.903

0.9402 0.9579 0.9698 0.9808 0.9887

0.9976 1.0000 0.9988 0.9973 0.9936

0.9810 0.9724 0.9634 0.9525 0.9402

0.9136 0.8985 0.8824 0.8651 0.8477

0.8105 0.7917 0.7711 0.7508 0.7293

0.6861 0.6632 0.6411 0.6179 0.5942

0.5472 0.5227 0.4987 0.4741 0.4495

0.3998 0.3751 0.3500 0.3249 0.2998

0.2494 0.2241 0.1989 0.1738 0.1488

0.0988 0.0739 0.0492 0.0245 0.0020
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==== XRay Tube Voltage 80 kVp, Source Energies

SI10 H 0.0130 0.0135 0.0140 0.0145 0.0150 0.0155

0.0160

0.0195

0.0230

0.0265

0.0300

0.0335

0.0370

0.0405

0.0440

0.0475

0.0510

0.0545

0.0580

0.0615

0.0650

0.0685

0.0720

0.0755

0.0790

0.0165

0.0200

0.0235

0.0270

0.0305

0.0340

0.0375

0.0410

0.0445

0.0480

0.0515

0.0550

0.0585

0.0620

0.0655

0.0690

0.0725

0.0760

0.0795

0.0170

0.0205

0.0240

0.0275

0.0310

0.0345

0.0380

0.0415

0.0450

0.0485

0.0520

0.0555

0.0590

0.0625

0.0660

0.0695

0.0730

0.0765

0.0800

0.0175

0.0210

0.0245

0.0280

0.0315

0.0350

0.0385

0.0420

0.0455

0.0490

0.0525

0.0560

0.0595

0.0630

0.0665

0.0700

0.0735

0.0770

0.0180

0.0215

0.0250

0.0285

0.0320

0.0355

0.0390

0.0425

0.0460

0.0495

0.0530

0.0565

0.0600

0.0635

0.0670

0.0705

0.0740

0.0775

0.0185 0.0190

0.0220

0.0255

0.0290

0.0325

0.0360

0.0395

0.0430

0.0465

0.0500

0.0535

0.0570

0.0605

0.0640

0.0675

0.0710

0.0745

0.0780

==== XRay Tube Voltage 80 kVp, Source Probabilities

SP10 D 0.0000 0.0000 0.0001

0.0003

A-5

0.0007

0.0225

0.0260

0.0295

0.0330

0.0365

0.0400

0.0435

0.0470

0.0505

0.0540

0.0575

0.0610

0.0645

0.0680

0.0715

0.0750

0.0785

0.0015
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0.0028

0.0531

0.2167

0.4345

0.6173

0.7249

0.7623

0.7519

0.7107

0.6530

0.5857

0.5140

0.7769

0.3672

0.2941

0.2223

0.1467

0.0824

0.0182

0.0050

0.0693

0.2461

0.4655

0.6392

0.7339

0.7630

0.7474

0.7036

0.6435

0.5758

0.5039

0.4302

0.3567

0.2839

0.2650

0.1375

0.0732

0.0091

0.0083

0.0877

0.2790

0.4938

0.6551

0.7422

0.7635

0.7421

0.6954

0.6347

0.5654

0.4933

0.4199

0.3464

0.2736

0.2005

0.1284

0.0640

0.0008

0.0131

0.1096

0.3098

0.5231

0.6737

0.7480

0.7626

0.7367

0.6877

0.6252

0.5556

0.4827

1.0000

0.3357

0.2632

0.1829

0.1191

0.0548

0.0197

0.1329

0.3403

0.5485

0.6883

0.7537

0.7607

0.7312

0.6794

0.6151

0.5452

0.4722

0.3987

0.3254

0.4525

0.1739

0.1100

0.0456

0.0284

0.1593

0.3732

0.5746

0.7024

0.7578

0.7587

0.7244

0.6702

0.6056

0.5350

0.4618

0.3881

0.3151

0.2427

0.1648

0.1008

0.0365

==== XRay Tube Voltage 100 kVp, Source Energies

0.0394

0.1868

0.4048

0.5958

0.7144

0.7601

0.7557

0.7183

0.6621

0.5957

0.5247

0.4514

0.3776

0.3046

0.2325

0.1558

0.0916

0.0273
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SI10 H 0.0135 0.0140 0.0145 0.0150 0.0155 0.0160 0.0165

0.0170 0.0175 0.0180 0.0185 0.0190 0.0195 0.0200
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0.0205

0.0240

0.0275

0.0310

0.0345

0.0380

0.0415

0.0450

0.0485

0.0520

0.0555

0.0590

0.0625

0.0660

0.0695

0.0730

0.0765

0.0835

0.0870

0.0905

0.0940

0.0980

==== XRay Tube Voltage 100 kVp, Source Probabilities

0.0210

0.0245

0.0280

0.0315

0.0350

0.0385

0.0420

0.0455

0.0490

0.0525

0.0560

0.0595

0.0630

0.0665

0.0700

0.0735

0.0770

0.0840

0.0875

0.0910

0.0950

0.0985

0.0215

0.0250

0.0285

0.0320

0.0355

0.0390

0.0425

0.0460

0.0495

0.0530

0.0565

0.0600

0.0635

0.0670

0.0705

0.0740

0.0775

0.0845

0.0880

0.0915

0.0955

0.0990

0.0220

0.0255

0.0290

0.0325

0.0360

0.0395

0.0430

0.0465

0.0500

0.0535

0.0570

0.0605

0.0640

0.0675

0.0710

0.0745

0.0780

0.0850

0.0885

0.0920

0.0960

0.0995

SP10 D 0.0000 0.0000 0.0001

0.0225

0.0260

0.0295

0.0330

0.0365

0.0400

0.0435

0.0470

0.0505

0.0540

0.0575

0.0610

0.0645

0.0680

0.0715

0.0750

0.0785

0.0855

0.0890

0.0925

0.0965

0.1000

0.0230

0.0265

0.0300

0.0335

0.0370

0.0405

0.0440

0.0475

0.0510

0.0545

0.0580

0.0615

0.0650

0.0685

0.0720

0.0755

0.0790

0.0860

0.0895

0.0930

0.0970

0.0235

0.0270

0.0305

0.0340

0.0375

0.0410

0.0445

0.0480

0.0515

0.0550

0.0585

0.0620

0.0655

0.0690

0.0725

0.0760

0.0795

0.0865

0.0900

0.0935

0.0975

0.0002 0.0003 0.0006
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0.0012

0.0172

0.0668

0.1372

0.2013

0.2434

0.2636

0.2672

0.2597

0.2457

0.2285

0.2098

0.1906

0.1716

0.1532

0.2105

0.1031

0.0782

0.0651

0.0516

0.0381

0.0246

0.0093

0.0020

0.0221

0.0766

0.1470

0.2080

0.2477

0.2651

0.2665

0.2579

0.2435

0.2258

0.2070

0.1879

0.1690

0.1505

0.1294

0.1015

0.0763

0.0631

0.0497

0.0361

0.0226

0.0075

0.0031

0.0279

0.0862

0.1574

0.2156

0.2512

0.2661

0.2658

0.2563

0.2412

0.2233

0.2042

1.0000

0.1662

0.1479

0.1114

0.0997

0.0745

0.0612

0.0478

0.0342

0.0188

0.0056

0.0047

0.0343

0.0958

0.1666

0.2220

0.2546

0.2668

0.2650

0.2543

0.2386

0.2206

0.2015

0.1824

0.1636

0.4285

0.1098

0.0980

0.0726

0.0593

0.0458

0.0323

0.0169

0.0037

0.0069

0.0416

0.1063

0.1762

0.2282

0.2575

0.2674

0.2638

0.2521

0.2362

0.2179

0.1988

0.1797

0.1611

0.1427

0.1081

0.0963

0.0707

0.0574

0.0439

0.0303

0.0150

0.0019

A-8

0.0096

0.0494

0.1167

0.1844

0.2338

0.2597

0.2676

0.2628

0.2503

0.2336

0.2152

0.1961

0.1770

0.1584

0.1402

0.1065

0.0946

0.0689

0.0554

0.0419

0.0284

0.0131

0.0001

0.0131

0.0580

0.1266

0.1928

0.2388

0.2619

0.2675

0.2612

0.2480

0.2311

0.2124

0.6539

0.1743

0.1557

0.1377

0.1049

0.0928

0.0670

0.0535

0.0400

0.0265

0.0112

RCD-25-008-0



==== XRay Tube Voltage 120 kVp, Source Energies

RCD-25-008-0

SI10 H 0.0140 0.0145 0.0150 0.0155 0.0160 0.0165 0.0170

0.0175

0.0210

0.0245

0.0280

0.0315

0.0350

0.0385

0.0420

0.0455

0.0490

0.0525

0.0560

0.0595

0.0630

0.0665

0.0700

0.0735

0.0770

0.0805

0.0840

0.0875

0.0180

0.0215

0.0250

0.0285

0.0320

0.0355

0.0390

0.0425

0.0460

0.0495

0.0530

0.0565

0.0600

0.0635

0.0670

0.0705

0.0740

0.0775

0.0810

0.0845

0.0880

0.0185

0.0220

0.0255

0.0290

0.0325

0.0360

0.0395

0.0430

0.0465

0.0500

0.0535

0.0570

0.0605

0.0640

0.0675

0.0710

0.0745

0.0780

0.0815

0.0850

0.0885

0.0190

0.0225

0.0260

0.0295

0.0330

0.0365

0.0400

0.0435

0.0470

0.0505

0.0540

0.0575

0.0610

0.0645

0.0680

0.0715

0.0750

0.0785

0.0820

0.0855

0.0890

0.0195

0.0230

0.0265

0.0300

0.0335

0.0370

0.0405

0.0440

0.0475

0.0510

0.0545

0.0580

0.0615

0.0650

0.0685

0.0720

0.0755

0.0790

0.0825

0.0860

0.0895

A-9

0.0200

0.0235

0.0270

0.0305

0.0340

0.0375

0.0410

0.0445

0.0480

0.0515

0.0550

0.0585

0.0620

0.0655

0.0690

0.0725

0.0760

0.0795

0.0830

0.0865

0.0900

0.0205

0.0240

0.0275

0.0310

0.0345

0.0380

0.0415

0.0450

0.0485

0.0520

0.0555

0.0590

0.0625

0.0660

0.0695

0.0730

0.0765

0.0800

0.0835

0.0870

0.0905



0.0910

0.0945

0.0980

0.1015

0.1050

0.1085

0.1120

0.1155

0.1190

C ==== XRay Tube Voltage 120 kVp, Source Probabilities

0.0915

0.0950

0.0985

0.1020

0.1055

0.1090

0.1125

0.1160

0.1195

0.0920

0.0955

0.0990

0.1025

0.1060

0.1095

0.1130

0.1165

0.1200

SP10 D 0.0000 0.0000

0.0014

0.0134

0.0437

0.0850

0.1233

0.1505

0.1653

0.1699

0.1678

0.1611

0.1520

0.1417

1.0000

0.0022

0.0165

0.0490

0.0908

0.1279

0.1534

0.1665

0.1701

0.1670

0.1598

0.1506

0.1402

0.1296

0.0032

0.0202

0.0549

0.0969

0.1324

0.1560

0.1676

0.1699

0.1660

0.1587

0.1491

0.1387

0.1281

0.0925

0.0960

0.0995

0.1030

0.1065

0.1100

0.1135

0.1170

0.0001

0.0045

0.0242

0.0608

0.1022

0.1366

0.1582

0.1684

0.1698

0.1653

0.1573

0.1477

0.1372

0.1266

0.0930

0.0965

0.1000

0.1035

0.1070

0.1105

0.1140

0.1175

0.0935

0.0970

0.1005

0.1040

0.1075

0.1110

0.1145

0.1180

0.0002 0.0003

0.0061

0.0286

0.0666

0.1077

0.1404

0.1603

0.1691

0.1693

0.1643

0.1560

0.1462

0.6237

0.1251

A-10

0.0081

0.0332

0.0728

0.1134

0.1440

0.1622

0.1695

0.1689

0.1632

0.1547

0.1448

0.1342

0.1237

0.0940

0.0975

0.1010

0.1045

0.1080

0.1115

0.1150

0.1185

0.0005

0.0105

0.0385

0.0787

0.1181

0.1475

0.1639

0.1698

0.1683

0.1623

0.1533

0.1432

0.1327

0.1222

RCD-25-008-0

0.0009



0.1206

0.1105

0.0771

0.0729

0.0684

0.0634

0.0581

0.0527

0.0471

0.0414

0.0356

0.0298

0.0240

0.0183

0.0126

0.0070

0.0015

0.1192

0.4195

0.0766

0.0723

0.0677

0.0626

0.0574

0.0520

0.0463

0.0406

0.0348

0.0290

0.0232

0.0175

0.0118

0.0062

0.0008

5.08E-11 inv sec

0.1178

0.1077

0.0759

0.0717

0.0670

0.0619

0.0566

0.0511

0.0455

0.0398

0.0340

0.0282

0.0224

0.0167

0.0110

0.0054

0.0001

0.1163

0.1063

0.0754

0.0711

0.0663

0.0612

0.0558

0.0503

0.0447

0.0389

0.0331

0.0274

0.0216

0.0159

0.0102

0.0046

0.1148

0.1049

0.0748

0.0704

0.0656

0.0605

0.0551

0.0495

0.0439

0.0381

0.0323

0.0265

0.0208

0.0150

0.0094

0.0039

C ===== AmBe Neutron Source Energies

SIM0 H

1.07e-5 3.73e-5 1.01e-4 2.14e-4 4.54e-4

1.58e-3 3.35e-3 7.10e-3 1.50e-2 2.19e-2

0.1134

0.1865

0.0742

0.0697

0.0649

0.0597

0.0543

0.0487

0.0430

0.0373

0.0315

0.0257

0.0199

0.0142

0.0086

0.0031

1.00e-7 4.14e-7 8.76e-7 1.86e-6 5.04e-6

A-11

0.1120

0.0981

0.0736

0.0691

0.0641

0.0590

0.0535

0.0479

0.0422

0.0365

0.0307

0.0249

0.0191

0.0134

0.0078

0.0023

RCD-25-008-0



RCD-25-008-0

2.42e-2 261e-2 3.18e-2 4.09e-2 6.74e-2
1.11e-1 1.83e-1 2.97e-1 3.69e-1 4.98e-1
6.08e-1 7.43e-1 8.21e-1 1.00 1.35
165 192 223 235 237
247 273 3.01 3.68 497
6.07 741 861 1.00e1 1.22e1
1.42e1 1.73e1
C ===== AmBe Neutron Source Probabilities
SP10 D 0.00 0.00 6.04e-8 1.28e-7 4.16e-7
7.36e-7 3.47e-6 8.36e-6 1.48e-5 3.13e-5
1.48e-4 2.30e-4 4.90e-4 1.04e-3 8.93e-4
3.00e-4 2.46e-4 7.53e-4 1.18e-3 3.46e-3
5.73e-3 1.09e-2 1.73e-2 1.08e-2 1.92e-2
1.54e-2 1.80e-2 9.02e-3 2.03e-2 3.37e-2
2.56e-2 2.55e-2 3.16e-2 1.17e-2 2.00e-3
1.03e-2 2.93e-2 4.24e-2 1.08e-1 1.81e-1
1.27e-1 1.11e-1 8.09e-2 3.16e-2 1.22e-2

0.00 0.00

9.16E-13 inv sec
C ===== PuBe Neutron Source Energies
SIM0 H 1.00E-11 1.00E-02 2.00E-02 5.00E-02 1.00E-01

2.00E-01 4.00E-01 6.00E-01 8.00E-01 1.00E+00

A-12



RCD-25-008-0

1.30E+00 1.70E+00 2.10E+00 2.40E+00 2.70E+00
3.00E+00 3.30E+00 3.60E+00 4.00E+00 4.40E+00
5.00E+00 6.00E+00 7.00E+00 8.00E+00 9.00E+00
1.00E+01 1.20E+01 1.50E+01 2.00E+01

C ===== PuBe Neutron Source Probabilities

SP10 D 0.0 1.47E+00 4.25E+00 2.53E+01 7.62E+01 2.29E+02
3.81E+03 1.57E+04 2.39E+04 2.59E+04 3.83E+04 3.87E+04
4.67E+04 4.65E+04 5.67E+04 9.16E+04 1.17E+05 1.10E+05
1.35E+05 1.23E+05 1.65E+05 1.65E+05 1.53E+05 1.73E+05

1.30E+05 7.86E+04 1.08E+04 7.41E-02 4.22E-03

A-13
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